Cisco ICM/IP Contact Center
Enterprise Edition
Template Design Guide Using
InfoMaker, Release 6.0(0)

ICM/IP Contact Center Enterprise Edition, Release 6.0(0)
May 2004

Corporate Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000
  800 553-NETS (6387)
Fax: 408 526-4100
CONTENTS

Preface i
  About This Guide i
  Other Publications ii
  Obtaining Documentation ii
  Documentation Feedback iii
  Obtaining Technical Assistance iii
  Obtaining Additional Publications and Information v

CHAPTER 1
Getting Started with InfoMaker 1-1
  About InfoMaker 1-1
  InfoMaker Support of ICM WebView 1-1
  How to Install InfoMaker 1-2
  How to Access InfoMaker 1-2
  About the InfoMaker Interface 1-2

CHAPTER 2
Introduction to Report Templates 2-1
  About ICM Report Template Attributes 2-1
  About ICM Databases 2-1
  About WebView Report Categories 2-2
  About SQL Select Statements 2-2
  About Required Arguments 2-3
  About Template Presentation Formats 2-3
  About Planning a New Report Template 2-4

CHAPTER 3
Creating a New Report Template 3-1
  Step 1: How to Select the Template Database 3-1
  Step 2: How to Specify the Report Category 3-3
  Step 3: How to Select the Presentation Style and Data Source 3-4
  Step 4: How to Create the SQL Statement 3-5
  Step 5: How to Design the Template Layout 3-10
  Step 6: How to Preview a Template 3-17
  Step 7: How to Save a Template 3-18
Contents

Step 8: Testing the Template 3-19

CHAPTER 4  Editing and Deleting Templates 4-1
  How to Edit a Template  4-1
  How to Delete a Template  4-2

CHAPTER 5  Deploying Custom Templates 5-1
  How to Access New Templates in WebView  5-1
  How to Prevent a Template from Displaying in WebView  5-2
  How to Distribute Templates to Other Template Libraries  5-3

APPENDIX A  Creating Sample Report Templates A-1
  How to Create a Sample Real-Time Template  A-1
  How to Create a Sample Historical Template  A-3

APPENDIX B  Template Libraries and Report Categories B-1
  About Template Libraries  B-1
  About WebView Report Categories  B-1

APPENDIX C  Considerations When Making Custom Reports C-1
  Use of an External Database  C-1
  Network Queue and Local Queue Time in TCDs  C-1
  RONA TCD and the Counting of Redirected Calls  C-1
  DBDateTime in HDS to Improve Extracts  C-2
Preface

This preface describes this guide’s scope and intended audience. It also provides general information on accessing Cisco product documentation and getting assistance with Cisco products. It contains these sections:

- About This Guide
- Other Publications
- Obtaining Documentation
- Obtaining Technical Assistance

About This Guide

Objective

This guide provides instructions for using InfoMaker from Sybase to create and modify report templates used in WebView in an ICM/IP contact center. WebView is the Web-based reporting tool of ICM software.

Audience

This guide is intended for Cisco Admin Workstation users who create and/or modify report templates for use in WebView reports. This guide assumes that you have knowledge of:

- ICM WebView and WebView reports
- ICM database table structures
- Relational databases and Structured Query Language (SQL).

Familiarity with Sybase InfoMaker is also useful.

Note

For instructions on installing and setting up WebView, see the Cisco ICM/IP Contact Center Enterprise Edition Installation and Administration Guide, Release 6.0(0). For instructions on using WebView, see the WebView online Help. For information on ICM databases, see the Cisco ICM/IP Contact Center Enterprise Edition Database Schema Handbook, Release 6.0(0) and the Schema Help available from the Cisco Admin Workstation program group.
Conventions

This guide uses the following conventions:

<table>
<thead>
<tr>
<th>Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boldface type is used for menu, tab, field, and command names.</td>
<td>From the <strong>File</strong> menu, select <strong>Save As</strong>.</td>
</tr>
<tr>
<td>Courier type is used for file names, directory paths, code, and user input.</td>
<td>Peripheral services templates are stored in the <strong>persvc</strong> subdirectory.</td>
</tr>
<tr>
<td>Italic type indicates one of the following: • A newly introduced term • An emphasized word or phrase • The title of a publication</td>
<td>• <strong>A skill group</strong> is a collection of agents who share similar skills. • Templates with computed columns created in the Report Painter <strong>will not</strong> support WebView’s drill-down and threshold capabilities. • For more information, see the <em>Cisco ICM Software Database Schema Handbook</em>.</td>
</tr>
<tr>
<td>An entry enclosed within angle brackets (&lt;&gt;) indicates a variable.</td>
<td>Save the file to the <strong>icm&lt;icm_instance_name&gt;</strong> directory.</td>
</tr>
<tr>
<td>A right angle bracket indicates an item from a pull-down menu or a series of sequential commands in a tabular dialog box or Wizard.</td>
<td>Select <strong>Peripheral &gt; Create a Report</strong> to browse to the custom templates.</td>
</tr>
</tbody>
</table>

Other Publications

For additional information about Cisco Intelligent Contact Management (ICM) software and the IPCC enterprise solution, see the customer contact software section at the [Cisco web site](http://www.cisco.com). 

Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several ways to obtain technical assistance and other technical resources. These sections explain how to obtain technical information from Cisco Systems.

Cisco.com

You can access the most current Cisco documentation at this URL: [http://www.cisco.com/univercd/home/home.htm](http://www.cisco.com/univercd/home/home.htm)
You can access the Cisco website at this URL:
http://www.cisco.com

You can access international Cisco websites at this URL:

**Ordering Documentation**

You can find instructions for ordering documentation at this URL:

You can order Cisco documentation in these ways:

- Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from the Ordering tool:
- Nonregistered Cisco.com users can order documentation through a local account representative by calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in North America, by calling 800 553-NETS (6387).

**Documentation Feedback**

You can send comments about technical documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

**Obtaining Technical Assistance**

For all customers, partners, resellers, and distributors who hold valid Cisco service contracts, Cisco Technical Support provides 24-hour-a-day, award-winning technical assistance. The Cisco Technical Support Website on Cisco.com features extensive online support resources. In addition, Cisco Technical Assistance Center (TAC) engineers provide telephone support. If you do not hold a valid Cisco service contract, contact your reseller.
Cisco Technical Support Website

The Cisco Technical Support Website provides online documents and tools for troubleshooting and resolving technical issues with Cisco products and technologies. The website is available 24 hours a day, 365 days a year at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com user ID and password. If you have a valid service contract but do not have a user ID or password, you can register at this URL:


Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 and S4 service requests are those in which your network is minimally impaired or for which you require product information.) After you describe your situation, the TAC Service Request Tool automatically provides recommended solutions. If your issue is not resolved using the recommended resources, your service request will be assigned to a Cisco TAC engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. (S1 or S2 service requests are those in which your production network is down or severely degraded.) Cisco TAC engineers are assigned immediately to S1 and S2 service requests to help keep your business operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your business operation are negatively affected by inadequate performance of Cisco products. You and Cisco will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations remain functional. You and Cisco will commit resources during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or configuration. There is little or no effect on your business operations.
Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available from various online and printed sources.

- Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Visit Cisco Marketplace, the company store, at this URL:
  http://www.cisco.com/go/marketplace/

- The Cisco Product Catalog describes the networking products offered by Cisco Systems, as well as ordering and customer support services. Access the Cisco Product Catalog at this URL:
  http://cisco.com/univercd/cc/td/doc/pcat/

- Cisco Press publishes a wide range of general networking, training and certification titles. Both new and experienced users will benefit from these publications. For current Cisco Press titles and other information, go to Cisco Press at this URL:
  http://www.ciscopress.com

- Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and networking investments. Each quarter, Packet delivers coverage of the latest industry trends, technology breakthroughs, and Cisco products and solutions, as well as network deployment and troubleshooting tips, configuration examples, customer case studies, certification and training information, and links to scores of in-depth online resources. You can access Packet magazine at this URL:
  http://www.cisco.com/packet

- iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies learn how they can use technology to increase revenue, streamline their business, and expand services. The publication identifies the challenges facing these companies and the technologies to help solve them, using real-world case studies and business strategies to help readers make sound technology investment decisions. You can access iQ Magazine at this URL:
  http://www.cisco.com/go/iqmagazine

- Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering professionals involved in designing, developing, and operating public and private internets and intranets. You can access the Internet Protocol Journal at this URL:
  http://www.cisco.com/ipj

- World-class networking training is available from Cisco. You can view current offerings at this URL:
Obtaining Additional Publications and Information
Getting Started with InfoMaker

This chapter describes InfoMaker capabilities, gives instructions for installing and accessing the product, and provides a brief description of the InfoMaker interface. It contains these sections:

- About InfoMaker, page 1-1
- InfoMaker Support of ICM WebView, page 1-1
- How to Install InfoMaker, page 1-2
- How to Access InfoMaker, page 1-2
- About the InfoMaker Interface, page 1-2

About InfoMaker

Sybase’s InfoMaker™ software allows you to create and modify the templates which serve as the basis for reports available through ICM WebView. WebView is ICM’s Web-based reporting tool, presenting call center information in both real-time and historical reports.

WebView ships with many predefined templates that cover a wide range of standard industry report formats. However, you may want to create your own report templates or modify those delivered with WebView.

InfoMaker Support of ICM WebView

ICM 6.0 ships with two “flavors” of WebView.

- ICM WebView reports on activity logged in ICM databases. It is installed on the ICM Admin Workstation server.
- CEM WebView reports specifically in Cisco e-Mail Manager activity. It is installed on the Cisco e-Mail Manager server.

Note

InfoMaker supports creation and modification of templates for ICM WebView only. Creation and modification of Cisco e-Mail Webview templates is not supported. All discussion of template creation, modification, and distribution in this guide should be understood to pertain to ICM WebView only.
How to Install InfoMaker

You can install InfoMaker as an option when you install the ICM Admin Workstation. Prior to installing the Admin Workstation, you MUST first install Sybase InfoMaker, version 8.0.1 on the server. Without a previous installation of InfoMaker, it will not be available for use.

To install InfoMaker:

1. Install Sybase InfoMaker, version 8.0.1, on the same server on which you will be installing the ICM Admin Workstation.

2. Install the Admin Workstation. During the installation:
   b. Click the Browse button next to the check box, and browse to select the directory where InfoMaker is installed.

Note: WebView in ICM 6.0 supports InfoMaker, version 8.0.1 only on the machine on which WebView is installed. You may use InfoMaker, version 8.0.3 on a machine not containing WebView. Other versions of InfoMaker are not supported.

If you install InfoMaker AFTER installing the Admin Workstation software, you must rerun the Admin Workstation Setup before InfoMaker will be available for use. For more information on installing the Admin Workstation, see the Cisco ICM Enterprise Edition Installation Guide, Release 6.0(0).

How to Access InfoMaker

You access InfoMaker through the ICM Admin Workstation. For this reason, you need Admin Workstation privileges in order to use InfoMaker. No other privileges are necessary to use the product.

To start InfoMaker:

1. From the ICM Admin Workstation program group, select InfoMaker. This launches InfoMaker running under ICM.

About the InfoMaker Interface

This guide does not include a full description of all InfoMaker features; it limits itself to the context of using InfoMaker to create and edit ICM report templates.

Note: For information on using InfoMaker features not described in this guide, see your InfoMaker documentation.

Most of the tasks related to report template in InfoMaker take place in the following three Painter windows:

- The Library Painter allows you to browse and view libraries and their contents.
- The SQL Select Painter allows you to define a template’s SQL select statement.
- The Report Painter allows you to design the layout for a template.
For descriptions and instructions on how and when to use these windows, see Chapter 3, “Creating a New Report Template.”

**Figure 1-1  InfoMaker Main Window**

The commands available to you in InfoMaker may vary depending on the configuration specified in your InfoMaker installation. Commands that appear in the default InfoMaker installation are described in the table below.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="new.png" alt="New" /></td>
<td>Use to create a new object (i.e., a report template).</td>
</tr>
<tr>
<td><img src="open.png" alt="Open" /></td>
<td>Use to open an existing object (i.e., a report template or query) from the current library.</td>
</tr>
<tr>
<td><img src="preview.png" alt="Preview" /></td>
<td>Use to preview a report template from the current library.</td>
</tr>
<tr>
<td><img src="sel_lib.png" alt="Sel Lib" /></td>
<td>Use to select the current library file.</td>
</tr>
</tbody>
</table>
Table 1-1  InfoMaker Main Window Commands (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Lib List" /></td>
<td>Use to add additional libraries to your search list (e.g., to locate library files that have been transferred from another Admin Workstation).</td>
</tr>
<tr>
<td><img src="image" alt="To-Do" /></td>
<td>Use to open the To-Do List, a user-defined list of outstanding tasks for the current library</td>
</tr>
<tr>
<td><img src="image" alt="Library" /></td>
<td>Use to open the Library painter, which allows you to browse and view libraries and their contents. Note: Selecting a library in the Library Painter does not set it as the current library; use the Select Library command for that purpose.</td>
</tr>
<tr>
<td><img src="image" alt="DB Prof" /></td>
<td>Use to set the current database connection, and to create or modify database profiles (connection information).</td>
</tr>
<tr>
<td><img src="image" alt="Dbase" /></td>
<td>Use to open the Database painter, which allows you to maintain databases and database tables, control user access to databases, and manipulate data in databases</td>
</tr>
<tr>
<td><img src="image" alt="Exit" /></td>
<td>Use to exit InfoMaker.</td>
</tr>
</tbody>
</table>
Introduction to Report Templates

This chapter describes the basic attributes that define and shape ICM report templates. It also describes points you should consider when planning a template. It contains these sections:

- About ICM Report Template Attributes, page 2-1
- About ICM Databases, page 2-1
- About WebView Report Categories, page 2-2
- About SQL Select Statements, page 2-2
- About Template Presentation Formats, page 2-3
- About Planning a New Report Template, page 2-4

About ICM Report Template Attributes

Each ICM WebView report template is defined and shaped by the following four basic attributes:

- **Database**: When you create a template, you specify whether it should include either real-time data (from the Admin Workstation local database) or historical data (from the ICM central database, or optionally, the ICM distributor database).

- **Report Category**: When you create a template, you save it to a PowerBuilder library file that associates it with a specific WebView report category (that is, call type, peripheral services, and so on).

- **SQL Statement**: When you create a template, you construct a Structured Query Language (SQL) select statement that determines what data is included in the report.

- **Presentation Format**: When you create a template, you specify its presentation format. The presentation format determines the format in which the report is rendered. ICM Webview templates can use either a graph (graphical) or tabular (text) presentation format.

For example, you can create a historical template for peripheral services that retrieves the total number of tasks handled by certain peripheral services and which displays the data in a tabular report.

About ICM Databases

Report templates can be created to include either real-time data or historical data.
• **Real-time data** describes conditions as they currently exist. The data is updated at regular intervals for up-to-the-minute accuracy. Real-time data is stored in the *Admin Workstation Local Database* (RealTimeDB). Each Admin Workstation contains a real-time database.

• **Historical data** describes conditions during a specified period of time, for example, a range of dates. Historical data is stored in two places:
  - The *ICM central database* (HistoricalDB) located on the central controller.
  - The *ICM distributor database* (Historical Database Server (HDS) machine), an Admin Workstation set up to store historical data so that other Admin Workstations at the site can read historical data from the HDS rather than accessing the central database.

For descriptions of the tables contained in ICM databases, see the *Cisco ICM/IP Contact Center Enterprise Edition Database Schema Handbook, Release 6.0(0).*

---

**Note**
Cisco does NOT recommend that you do any reporting on the TCD (Termination Call Detail) and TCV (Termination Call Variable) database tables within a production system logger, or even a production system HDS. If you plan to use the data in these tables, you should set up periodic off-peak-hour extracts into an external database, and run your reports in that external database. The Cisco Technical Assistance Center (TAC) Web Site at Cisco.com can give you recommendations on how to do these extracts.

---

**About WebView Report Categories**

ICM report templates are stored in and accessed from PowerBuilder library files (PBLs) on your ICM Workstation server. A separate library file exists for each WebView report category (for example: call type, agent team, and routing client). The library file for each report category is stored in its own subdirectory within the `<icm_instance_name>/aw/custom` directory.

---

**Note**
It is important to select the appropriate library when creating a new template: this is what associates the template with a specific report category, ensuring that it displays under the correct menu in WebView and has access to the correct retrieval values.

For more information, including a complete list of WebView report categories, see Appendix B, “Template Libraries and Report Categories.”

---

**About SQL Select Statements**

WebView templates use SQL select statements to determine what data to retrieve from the database. Select statements for WebView templates always include a Where clause that uses retrieval arguments to narrow the focus of a report to specific ICM entities and, in the case of historical reports, a specific date/time range. When a WebView user launches a report, the user is prompted to provide values for these arguments.

The following shows a sample SQL select statement from a WebView report:

```sql
SELECT Service.EnterpriseName, Service_Real_Time.CallsOfferedHalf
FROM Service, Service_Real_Time
WHERE (Service.SkillTargetID=Service_Real_Time.SkillTargetID) and
((Service.SkillTargetID in (:list_of_persvc))
```
In this example, the Where clause requests data based on skill target ID. A skill target is an ICM entity (such as a service, skill group, or agent) to which an ICM task is routed. A skill target ID is the unique identifier for a skill target. (:list_of_persvc) is the retrieval argument that accepts the list of skill target IDs specified by WebView users when they launch the report.

**About Required Arguments**

WebView prompts users to provide a fixed set of argument values (for the SQL statements) when launching a report:

- Real-time reports always use one argument—a list of IDs (argument data type is NumberArray) that represent the entities listed in the report.
- Historical reports always use three arguments—a list of IDs (argument type is number array), and start and end date/times that define the report’s time frame (argument data type for both is DateTime).

When creating a new template, you must create retrieval arguments in your SQL select statement to accept these values. Note that these are the only arguments WebView supports.

**About Complex Report Templates**

This guide provides the basic information needed to create most report templates. However, some templates (for example, the enterprise services and enterprise skill groups) mandate the use of complex SQL statements and advanced InfoMaker features. For example, many enterprise templates use:

- Long lists of computed fields defined within the SQL syntax
- Rows joined across three or more database tables
- Group By clauses, which must be defined within the SQL syntax, and cannot be viewed through the InfoMaker graphical interface

If you need assistance to create more complex report templates, ask your Cisco representative about consulting services.

**Note**

By default, InfoMaker defines inner joins. If you purchased the ICM partitioning option, using outer joins may cause errors for some ICM tables.

**About Template Presentation Formats**

A template’s presentation format determines the format in which the report is rendered. ICM WebView templates can use either a graph (including pie charts and bar charts) or tabular (text) presentation format.

Different types of report templates typically (though not always) use different visual representations:

- Real-time report templates are typically (though not always) represented by graphs.
- Historical report templates are typically (though not always) represented by tables.
About Planning a New Report Template

Before creating your first report template, you should be familiar with the ICM database schema. It is also a good idea to examine some of the standard templates that ship with ICM to familiarize yourself with their content and structure.

Any time you create a new template, you should first consider the following:

- **Which ICM database will the template use?**
  Will the template’s data be real-time or historical? A template can use data from only one source: real-time data, from the Admin Workstation local database, or historical data, from the ICM central database or HDS.

- **What ICM entity will the template report on?**
  The ICM entity you want to target (For example: agents, call types, peripheral services) determines the template’s Webview report type, and consequently the particular template library in which it should be stored. For more information on libraries and WebView report types, see Appendix B, “Template Libraries and Report Categories.”

- **What data will appear in the template?**
  Which database tables and columns do you want to include in the template? For information on ICM databases, see the Cisco ICM/IP Contact Center Enterprise Edition Database Schema Handbook, Release 6.0(0) and the Schema Help available from the Cisco Admin Workstation program group.

- **What arguments will the template require to retrieve data?**
  WebView users are prompted to specify certain data retrieval parameters when launching a report template:
  - Real-time reports always provide one argument—a list of IDs that represent the entities listed in your report.
  - Historical reports always provide three arguments—a list of IDs, and start and end dates and times that specify the period of time represented in your report.

- **What computed fields, if any, will the template include?**
  Your template can include computed columns that reflect calculations based on the values of two more database columns. Computed columns can be created at two points in the template creation process: when creating the template’s SQL statement (in the SQL Select Painter), or when designing the template’s layout (in the Report Painter). Templates containing computed columns created in the Report Painter will not support WebView’s drill-down and threshold capabilities.
What presentation format will the template use, graph or table?
ICM templates can use either a tabular (text) or graph (graphical) presentation format. Different types of templates typically (though not always) use different visual representations:

Will a modified version of an existing template suit your needs?
You can edit an existing template and save it under a different name, thus creating a new template from an existing one. Instructions for modifying existing templates are described in Chapter 4, “Editing and Deleting Templates.”
About Planning a New Report Template
Creating a New Report Template

This chapter describes the steps required to create a new report template. Except where specified, these steps are common to both real-time and historical reports. It contains these sections:

Step 1: How to Select the Template Database, page 3-1
Step 2: How to Specify the Report Category, page 3-3
Step 3: How to Select the Presentation Style and Data Source, page 3-4
Step 4: How to Create the SQL Statement, page 3-5
Step 5: How to Design the Template Layout, page 3-10
Step 6: How to Preview a Template, page 3-17
Step 7: How to Save a Template, page 3-18
Step 8: Testing the Template, page 3-19

Note
If this is your first new template, be sure to first review the information in Chapter 2, “Introduction to Report Templates.” In particular, review the information in the ”About Planning a New Report Template” section.

Step 1: How to Select the Template Database

The first step in creating a new report template is to specify which ICM database the template will use.

About ICM Databases

The ICM database you choose for your template will depend on whether you are creating a real-time or historical report:

- Real-time report templates must use the Admin Workstation local database.
- Historical report templates must use the ICM distributor database.
How to Specify the Database for a Template,

To specify the database for a template:

1. On the InfoMaker toolbar, click DB Prof. The Database Profiles dialog box opens.
2. From the ODBC interface, select either RealTimeDB (the Admin Workstation local database) or HistoricalDB (the ICM distributor database).

Note If either of these profiles is absent from the dialog box, you can add them as described in the next section, How to Create an ICM Database Profile, page 3-2.

3. Click Connect.
4. Click Close.

Figure 3-1 The Database Profiles Dialog Boxes

How to Create an ICM Database Profile

If a profile does not already exist for either the Admin Workstation local or ICM distributor database, you can create one as follows:

1. In the Database Profiles dialog box, highlight the ODBC entry.
2. Click New. The Database Profiles setup - ODBC dialog box opens.
3. On the **Connection** tab, enter:
   - **Profile Name**: Enter the profile name (RealTimeDB or HistoricalDB).
   - **Data Source**: Select the appropriate ICM database.
   - **Login ID**: Enter the database’s administrator ID.
   - **Password**: Enter the database’s administrator password.

4. On the **Options** tab, check the **Integrated Security** checkbox (required to successfully connect the database).

5. Click **OK**.

### Step 2: How to Specify the Report Category

After selecting the database, the next step in creating a report template is to specify the template’s report category.

### About WebView Report Categories Libraries

ICM report templates are stored in and accessed from PowerBuilder library files (PBLs) on your ICM Workstation server. A separate library file exists for each WebView report category (for example: call type, routing clients, and so on). By saving a template to a specific library, you associate it with a specific report category.

The library file for each report category is stored in its own subdirectory within the `icm\<icm_instance_name>\aw\custom` directory. For example, the library for the category **call type** is stored in a subdirectory named `caltyp`. The same library file stores both real-time and historical reports.

For more information on WebView report categories and library files, see Appendix B, “Template Libraries and Report Categories.”

### How to Specify the Report Category

To specify the report category for a new template, you must set that category’s library file as the current InfoMaker library. Later, when you save the template, it will automatically save to that library.

To select the current library:

1. From the InfoMaker main window, on the toolbar, click **Select Library**. The Select Library dialog box opens.

2. Open the subdirectory for the WebView report category in which you want to create the template (a list of all report categories appears in Appendix B, “Template Libraries and Report Categories.”)

3. Double-click the subdirectory’s library file (`ppb050.pbl`). The Select Library dialog box closes.
Step 3: How to Select the Presentation Style and Data Source

After selecting the database and template library, the next step in creating a report template is specify its presentation style and data source.

About Presentation Styles and Data Sources

Presentation style determines the format in which reports based on a template are displayed in WebView. WebView supports two InfoMaker presentation styles:

- Tabular (text-based in table format)
- Graph (including pie charts, bar charts, line charts, and so on)

Other presentation styles available in InfoMaker (Free Form, Composite) are not supported.

The data source determines how data is extracted from the database. WebView supports only SQL Select. Other data source methods available in InfoMaker (for example: Quick Select and Query) are not supported.

How to Select the Presentation Style and Data Source

To select a presentation style and data source:

2. On the Object tab, select either **Graph** or **Tabular** as your presentation style. These are the only presentation styles supported by WebView.

> **Note** The Tabular style lets you move columns around in InfoMaker while the Grid style does not allow that, though they both produce reports with table formats.
3. Click OK. The Report Generator wizard opens.
4. Select SQL Select as your data source. SQL Select is the only data source supported by WebView.
5. Click Next. An untitled Report window appears along with the Select Tables dialog box.

**Step 4: How to Create the SQL Statement**

The fourth step in creating a report template is to create the SQL statement.

**About SQL Statements**

The SQL statement selects the data to be included in the report.

---

**Note**

This guide assumes that you already have a good knowledge of SQL and the ICM database. ICM tables are described in-depth in the *Cisco ICM/IP Contact Center Enterprise Edition Database Schema Handbook*. Prior to creating your SQL statement (and, indeed, a new template), it might also be a good idea to examine a similar standard ICM report template.

Creating the SQL statement consists of:
- Selecting the tables and columns to use in the template.
- Optionally, creating computed columns.
- Creating a retrieval argument(s) — one for a real-time template and three for an historical one.
- Constructing a Where clause.

---

**Note**

InfoMaker allows you to incorporate elements in SQL statements that are not covered in this guide (for example, Group Bys). For information on these additional elements, consult your InfoMaker documentation.

---

**How to Select the Template Database Tables and Columns**

To select the database tables and columns to use in your template:

1. In the Select Tables dialog box, select one or more database tables whose data will appear in the template.
2. Click Open. The tables you selected display in the SQL Select Painter window.
   - The SQL Select Painter consists of two sections: the Table Select window (upper), and the SQL Toolbox window (lower).
   - To select additional tables, right-click in an empty area in the Table Select window and choose Select Tables from the popup menu.
   - To deselect a table, right-click on its title and choose Close from the popup menu.
3. In each table, select the columns that you want to display in the report. The columns you select display in the left side of the Sort tab in the SQL Toolbox.
   - To deselect a column, click its name a second time.

4. Optional: If the report’s presentation type is tabular, you can specify the column order and sort order by dragging column names from the left side of the Sort tab to the right.
   - Within the right-side of the Sort tab, you can drag columns up and down to arrange into the position you want them to appear in the report.
   - By default, column values are sorted in ascending order. To sort a column in descending order, clear its Ascending checkbox. In an actual report, records will be sorted initially using the first column’s sort order. For records whose first column value is identical, the next column’s sort order will be used, and so on.

How to Create the Retrieval Argument(s)

About Retrieval Arguments for WebView Reports

When a WebView user generates a report, the user specifies retrieval criteria whose values are passed to the template. To enable your template to use these values, you must define corresponding retrieval arguments in your SQL select statement.

Each WebView template must include a specific set of retrieval arguments:
All templates must include an argument that retrieves a list of IDs for the report category. For example, call type templates must include an argument that retrieves a list of call type IDs. The data type of the ID argument is always NumberArray.

Historical templates must also include start date and end date arguments. The data type for both is DateTime.

Note

These are the only arguments supported for WebView reports. Templates that include arguments beyond those described here will fail to retrieve data in WebView.

How to Create the Retrieval Argument(s)

To create the template’s retrieval argument(s):

1. From the InfoMaker Design menu, choose Retrieval Arguments. The Specify Retrieval Arguments dialog box opens.
2. In the Name field, enter a name for the ID argument. The name should not include spaces.
3. Example: skill_set_id
4. From the Type drop-down list, select NumberArray. If you are creating a real-time template, go to Step 6.
   
   Note
   You need only 1 argument in a real-time template. For historical templates, you need 3 arguments.

5. If you are creating an historical report, click Add and create two additional arguments: one for the start date and one for the end date, using DateTime as the data type.
6. Click OK. The Specify Retrieval Arguments dialog box closes.

How to Construct the Where Clause

The statement’s Where clause uses the retrieval arguments you created to limit data retrieval to records that match certain criteria. If desired, you can add additional Where criteria that do not use arguments to further narrow the scope of the report.

To specify the Where criteria:

1. In the SQL Toolbox, click the Where tab.
2. In the Column drop-down list, select the table column whose data will be matched against your first retrieval argument.

   Note
   An ID argument must reference a specific database column based on its report category. Appendix B, “Template Libraries and Report Categories” lists the database columns to use with each report category.

3. In the Operator drop-down list, select the operator you want to use.
4. In the Value field, right-click and select Argument from the popup menu.
5. A dialog box opens displaying the list of defined arguments. Select the argument appropriate for your column.

6. As necessary, to add additional Where criteria, from the Logical drop-down list, select AND.

   Note: Because the DateTime intervals specified in the historical database represent the beginning of an interval, Argument end date expressions must use < (not \(\leq\)) as the operator.

For Example: A historical report might contain these elements:

<table>
<thead>
<tr>
<th>Column</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>my_table.entityID</td>
<td>=</td>
<td>:NumberArray</td>
</tr>
<tr>
<td>my_table.my_date</td>
<td>&gt;=</td>
<td>:start_date</td>
</tr>
<tr>
<td>my_table.my_date</td>
<td>&lt;</td>
<td>:end_date</td>
</tr>
</tbody>
</table>

How to Create a Computed Column

Optionally, you can create computed columns that reflect calculations based on the values of two more database columns. You can create computed columns in both real-time and historical templates.

   Note: You can also create computed columns later in the template creation process when designing the template’s layout in the Report Painter. However, templates that contain computed columns created in the Report Painter will not support WebView’s drill-down and threshold capabilities.

To create a computed column:

1. In the SQL Toolbox, click the Compute tab.

2. In the Computed Columns field, enter a name for the column followed by an equal (=) sign. The computed column name cannot contain spaces.

3. Right-click to the right of the equal sign and select Columns from the popup menu.

4. Select the column you want to use and click Paste. The column is entered into the Computed Columns field.

5. Enter the symbol for the mathematical operation you want to perform (for example: +, -, /, *).

6. Right-click again in Computed Columns and again select Columns from the popup menu.

7. Select a second column to act upon the first and click Paste.

   Note: When your computed column is complete, it is added to the list of template columns on the left-side of the Sort tab in the SQL Toolbox.
How to View and Save a Completed SQL Statement

After completing your template’s SQL statement, you can view the entire statement by clicking the Syntax tab in the SQL Toolbox.

An example of a completed SQL statement that includes a computed field (AvgHandleTime) and ID, start date, and end date arguments:

```sql
SELECT Service.EnterpriseName,
       Service_Half_Hour.DateTime,
       Service_Half_Hour.CallsOfferedToHalf,
       Service_Half_Hour.CallsHandledToHalf,
       Service_Half_Hour.AvgDelayQToHalf,
       Service_Half_Hour.HandleTimeToHalf,
       Service_Half_Hour.ServiceLevelToHalf,
       Service_Half_Hour.CallsAbandQToHalf,
       AvgHandleTime=Service_Half_Hour.HandleTimeToHalf/Service_Half_Hour.CallsHandledToHalf
FROM Service, Service_Half_Hour
WHERE ( Service.SkillTargetID = Service_Half_Hour.SkillTargetID ) and
       ( ( Service.SkillTargetID = :servicesList )
         AND
         ( Service_Half_Hour.DateTime >= :start_date )
         AND
         ( Service_Half_Hour.DateTime < :end_date )
       )
ORDER BY Service.EnterpriseName ASC,
         Service_Half_Hour.DateTime DESC,
         Service_Half_Hour.CallsOfferedToHalf ASC
```

**Note**
- WebView real-time report templates can have only one retrieval argument, the argument must be of type Number Array and should be used in a Where clause of a SQL query.
- WebView historical report templates can have only three retrieval arguments, one of type Number Array and two of type DateTime.

How to Save a SQL Statement

If desired, InfoMaker allows you to save a SQL statement so that it can be retrieved and used in other report templates.

To save a SQL statement

1. With the statement displayed in the SQL Select Painter, on the InfoMaker toolbar, click **Save**. A dialog box opens prompting
2. Enter name for the statement.
3. Select the library file in which to save it.
4. Click **OK**.
Note

The template should be saved in the ppb050.pbl file under the correct folder 
<drive>\icr\<inst>\aw\custom\<category>\ppb050.pbl. The template will show up only under 
the <category> folder in the ppb050.pbl file where the custom template was created.

---

**Step 5: How to Design the Template Layout**

Once you have completed the SQL Select statement, you are ready to design the template’s layout. Different options are available depending on whether your template’s presentation style is graphic or tabular. The following sections describe these options. You should also be aware of the following guidelines and tips.

This section covers:
- **Template Guidelines**, page 3-10
- **Template Layout Tips**, page 3-11
- **How to Design the Layout for a Graphic Template**, page 3-12
- **How to Design the Layout for a Tabular Template**, page 3-13

**Template Guidelines**

Use the following guidelines when designing the template layout.

**Table 3-1 Template Layout Guidelines**

<table>
<thead>
<tr>
<th>Column type</th>
<th>Align</th>
<th>Units</th>
<th>Style</th>
<th>Size</th>
<th>Font</th>
<th>Back-ground Color</th>
<th>Text Color</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datawindow</td>
<td>PB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>window background</td>
<td>window text</td>
<td>&quot;From: &quot; + start_date + &quot; &quot; + &quot;To: &quot; + end_date</td>
</tr>
<tr>
<td>Title</td>
<td>left</td>
<td>no</td>
<td>Tahoma</td>
<td>11</td>
<td>bold</td>
<td>white</td>
<td>window text</td>
<td></td>
</tr>
<tr>
<td>FROM-TO Dates</td>
<td>left</td>
<td>no</td>
<td>Tahoma</td>
<td>8</td>
<td>white</td>
<td>window text</td>
<td>window text</td>
<td></td>
</tr>
<tr>
<td>Header’s Columns</td>
<td>center</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td>bold</td>
<td>transparent</td>
<td>window text</td>
<td></td>
</tr>
<tr>
<td>Header Band</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>button face</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detail’s data (string)</td>
<td>left</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td>transparent</td>
<td>window text</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 3-1  Template Layout Guidelines (continued)

<table>
<thead>
<tr>
<th>Column type</th>
<th>Align</th>
<th>Units</th>
<th>Style</th>
<th>Size</th>
<th>Font</th>
<th>Back-ground Color</th>
<th>Text Color</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail's data (number)</td>
<td>right</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td></td>
<td>transparent</td>
<td>window text</td>
<td>[General]</td>
</tr>
<tr>
<td>Detail's data (percent)</td>
<td>right</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td></td>
<td>transparent</td>
<td>window text</td>
<td>0.00%</td>
</tr>
<tr>
<td>Detail's data (average)</td>
<td>right</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td></td>
<td>transparent</td>
<td>window text</td>
<td>0.00</td>
</tr>
<tr>
<td>Detail's data (time)</td>
<td>right</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td></td>
<td>transparent</td>
<td>window text</td>
<td>00:00:00</td>
</tr>
<tr>
<td>Detail's data for Half Hour Reports (datetime)</td>
<td>left</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td></td>
<td>transparent</td>
<td>window text</td>
<td>[shortdate] [time]</td>
</tr>
<tr>
<td>Detail's data for Daily Reports (datetime)</td>
<td>left</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td></td>
<td>transparent</td>
<td>window text</td>
<td>[shortdate]</td>
</tr>
<tr>
<td>Summary's column</td>
<td>right</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td>bold</td>
<td>transparent</td>
<td>window text</td>
<td></td>
</tr>
<tr>
<td>Summary's data (number)</td>
<td>right</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td>bold</td>
<td>transparent</td>
<td>window text</td>
<td>[General]</td>
</tr>
<tr>
<td>Summary's data (percent)</td>
<td>right</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td>bold</td>
<td>transparent</td>
<td>window text</td>
<td>0.00%</td>
</tr>
<tr>
<td>Summary's data (average)</td>
<td>right</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td>bold</td>
<td>transparent</td>
<td>window text</td>
<td>0.00</td>
</tr>
<tr>
<td>Summary's data (time)</td>
<td>right</td>
<td>no</td>
<td>Arial</td>
<td>8</td>
<td>bold</td>
<td>transparent</td>
<td>window text</td>
<td>00:00:00</td>
</tr>
<tr>
<td>Group summary Band</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>button face</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Summary Band</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>button face</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Template Layout Tips**

- Any **computed** fields (from header groups 1, 2, 3), used in summary row calculations, or any detail computed fields should have the "Visible" property unchecked.
- Any **space** and **text** fields used for alignment should have the"Visible" property unchecked.
- Headers should not have more then three lines. This means that headers which are subheaders should not consist of more then two lines.
- **Daily** reports should have the Date column showing only the date and not the time. Also Daily report titles should say Daily and not Half Hour report.
- **Headers** should be vertical aligned to the top and centered horizontally in the PowerBuilder.
Step 5: How to Design the Template Layout

Chapter 3  Creating a New Report Template

- All columns fields (headers, invisible fields, detail, and summary fields) should be aligned and have the same width.
- All rows (invisible fields, detail, and summary fields) should have the same height.
- A column belonging to each member of a group should have its right edge aligned with the right edge of any adjoining header or detail column.
- You have to play with the formatting (possible overlapping headers) to get the html output user friendly.
- Sometimes, PowerBuilder is forgiving, sometime is not.
- For all templates (except the ‘all fields’ templates) the header’s name should be the database column name + "_t" for the sorting feature.
- When you create a new template, do not forget to check the HTML Datawindow check box.

How to Design the Layout for a Graphic Template

To specify the layout for a graph template:

1. After completing the template’s SQL statement, on the InfoMaker toolbar, click Return. The Define Graph Data dialog box opens.
2. From the Category drop-down list, select the template column you want to assign to the Category axis. This represents the column whose values will serve as the grouping criteria for the report.
3. From the Values drop-down list, select the template column that you want to assign to the Values axis. This represents the column whose values will be measured for each category.
4. Optionally, if you want to graph more than one series, select the Series check box and specify the column that will provide the series values.
5. Click Next. The Define Graph Style dialog box appears.
6. In the Title field, enter a title for the report. This is the text that will appear at the top of the report when it is viewed online or printed. It also appears alongside the template file name when the template is listed in WebView.
7. In Graph Type, select the graph’s graph type (for example: pie chart or bar chart).
8. Click Next. The attributes of the graph of the graph are displayed.
Chapter 3  Creating a New Report Template

Step 5: How to Design the Template Layout

Additional Design Options

Once your template launches in the Report Painter, it is functionally complete and ready to save and use. The Report Painter gives you additional options for customizing the design of report templates (for example, setting font and print specifications, creating footers, and so on). It also allows you to change the selections you made earlier in the Define Graph Data dialog box. These and other uses of the Report Painter window lie outside the scope of this document. For more information on using the Report Painter, consult your InfoMaker documentation.

How to Design the Layout for a Tabular Template

To specify the layout for a tabular template:

1. After completing the template’s SQL statement, on the InfoMaker toolbar, click Return. The Tabular Report Generator dialog box opens.

Note  If, when you click Return, the following message displays: “Data conversion resulted in overflow. Do you want to correct errors?” select Yes and then click Return again.
2. As desired, specify the template’s background, text, and column colors.
3. Click Next. The attributes of the tabular template are displayed.

**Figure 3-5  The Report Painter - Grid**

**How to Modify Column Header Properties**

To modify the attributes of a column header in a tabular report template:

1. In the Design window, in the Header Row box, click the column header you want to modify. The header’s attributes display in the Properties Window.
2. In the Properties window, modify the column header’s text, border, alignment, and other attributes as desired.
How to Modify Column Data Properties

To modify the attributes of a data column in a tabular report template:

1. In the Design window, in the Detail Row box, click the column you want to modify. To select multiple columns, hold down the Ctrl key as you select them. The column’s attributes display in the Properties Window.
2. In the Properties window, modify the data column’s font, border, alignment, format, and other attributes as desired.

How to Modify the Display Format of Column Data

As desired, you can modify the format in which a column’s data is displayed. For example, you could change the format of a column whose data displays as a decimal so that it displays as a percent.

To change a column’s display format:

1. In the Header row, click the column’s header to select it.
2. From the Edit menu, choose Select > Select Below to select all rows in the column.
3. From the Format menu, select a format for the column (for example: Percent).

Note: You can also set the display format for a column by selecting it and then clicking the Format tab in the Properties window.

How to Adjust Row Height and Column Width

InfoMaker does not automatically size table cells to display all header and detail text. In most cases, some manual resizing is required.

To adjust the height and width of template rows and columns:

1. To adjust width, in the Design window, click and drag column rules to their desired width.
2. To adjust the height of the header row, in the Design window, click and drag the Header Bar.
3. To adjust column width, in the Design window, click and drag the Detail Bar.

How to Add a Data Summary Row

You may want to add a row that will summarize (For example, give a total or average of) the values in some of the template’s data columns.

To add a data summary row:

1. In the Design window, click and drag the Summary bar to create room for a new blank row.
2. In the Header Box, click the header of the first column for which you want to create a summary.
3. From the Edit menu, choose Select > Select Below to highlight all the cells in the column.
4. From the Insert menu, choose Control > followed by the desired summary type (that is, Average, Count, or Sum). A summary field for the column is added to the new row displaying the field’s syntax.
Step 5: How to Design the Template Layout

Note
Simple calculations (such as summary row data) can be done in design mode. More complex computed columns (such as the Average Handle Time column) must be created in data source mode or the template will not have drill-down and threshold capabilities when launched in WebView.

5. Repeat steps 1-4 to add additional summary fields, as desired.

Note
Some summary fields may require more complex calculations than can be described in this guide. Examples of more complex calculations can be found in some of the ICM WebView standard.

6. To add a row label for the summary row:
   a. On the InfoMaker toolbar, click Text.
   b. In the Detail window, click in an open area in the summary row. A selected Text field appears.
   c. On the General tab in the Properties window, navigate to the Text field and enter a label.

How to Enable a Tabular Template for Drill-Down

WebView’s drill-down feature allows users to launch a detailed sub-report from within the current report window. The sub-report uses the same retrieval argument values as the report from which it was launched.

Drill-down is supported for tabular templates only, and only for templates created for these report categories:

- Enterprise Service
- Enterprise Skill Group
- Peripheral
- Peripheral service
- Peripheral skill group

To enable a valid template for drill-down:

1. In the Column Specification tab in the Data window, click the category column name.
2. In the General tab in the Properties window, modify the category column name by deleting the table portion of the column specification. So for example, modify the column specification service.enterprisename to enterprisename.

How to Add a Column

1. Position the cursor where you want to add a column. If the column location will be the last column in the table, go to Step 3. Otherwise go to Step 2.
2. If you need to make space for the column between other columns, select the columns that will be to the right of the new column and move them to the right, while keeping their alignment. You can do this by holding down the Ctrl key while clicking on each of the fields in each column that you want to move and then moving the cursor.
3. Enter the new header and field information for the new column, align the new fields, and then align the column with the other columns. To align fields, select the fields while holding down the Ctrl key and then from the menubar, select Format > Align.

If you have any questions, see the InfoMaker online help.

**How to Delete a Column**

1. While holding down the Ctrl key, select each field in the column.
2. Right click the mouse, and from the pop-up menu, click Delete.
3. In the same you selected the column to delete, select any columns to the right of the missing column and move them to the left to fill the empty column space, making sure the alignment remains between all columns.

**About Additional Design Options**

The Report Painter gives you additional options for customizing the design of report templates (for example, setting font and print specifications, and so on). These and other uses of the Report Painter window lie outside the scope of this document. For more information on using the Report Painter, consult your InfoMaker documentation.

**Step 6: How to Preview a Template**

To check layout, you can preview report templates directly from within InfoMaker. Templates can be previewed with or without data, and can be previewed regardless of whether or not they are open at the time.

**How to Preview an Open Template**

You can preview open templates in the Preview window in the Report Painter. The Preview window is a child window which, by default, is tiled within the Report Painter. For best viewing, it should be maximized.

To maximize the Preview window:

1. In the Report Painter, position your mouse point near the top of the Preview window, until a window bar with a Maximize button appears.
2. Click Maximize. The Preview window expands to full-screen mode.
3. Optionally, to retrieve data into the displayed template, from the Rows menu, select Retrieve. If prompted, provide values for required arguments.

**How to Preview a Closed Template**

At any time, from any place in InfoMaker, you can preview any template in the current library, even if the template is not currently open.
Chapter 3  Creating a New Report Template

Step 7: How to Save a Template

The next step in creating a template is to save it. (Note that you can—and are advised to—save at any point during the process.)

To save a report template:

1. With the template displayed in the Report Painter, from the File menu, select Save As. The Save Report dialog box opens.
2. Enter a name for the new template. When naming a template:
   - You cannot use spaces.
   - Because the template name will display in WebView, it’s a good idea to choose an intuitive name that describes some of the template’s basic attributes (for example: category, content, and presentation type).
   - Avoid choosing a name that could be overwritten by subsequent installations of ICM which include additional standard templates. A simple work around to this is to affix the word "custom" to the end of the name; for example: persvc_calls_offered_day_graph_custom.
   - To distinguish the environment in which the template can be used, use the following prefixes (if you want them displayed in WebView in the appropriate environment list):
     - ipcc_custom_templateName for templates that can be used to report on only ICM with IPCC configurations. For example, ipcc_custom_agent_real_time.
     - olds_custom_templateName for templates that can be used to report on only ICM legacy ACD configurations. For example, olds_custom_agent_real_time.
     - both_custom_templateName for templates that can be used to report on both ICM with IPCC configurations and ICM with legacy ACD configurations. For example, both_custom_agent_real_time.
3. In the Comments field, enter a brief description of the template. This description will display below the template name when it is listed in WebView.
4. Click OK.
Step 8: Testing the Template

You can validate the data when you are in InfoMaker. However, you need to publish the report in the AW distributor to test the format.

Note

Once you save your template, it can be deployed (made visible) in WebView. For instructions on deploying templates, see Chapter 5, “Deploying Custom Templates.” That chapter also describes methods for "hiding" incomplete or untested templates from WebView.
Chapter 4

Editing and Deleting Templates

This chapter describes how to edit and delete existing template files. It contains these sections:

- How to Edit a Template, page 4-1
- How to Delete a Template, page 4-2

How to Edit a Template

You can modify any ICM template, including the default templates that ship with ICM. In addition to simple modification of an existing template’s layout or data source, you can use editing to create new templates from existing ones (by saving a modified file under a new name).

To edit a template:

1. Set the current library file:
   a. From the InfoMaker main window, on the toolbar, click Select Library. The Select Library dialog box opens.
   b. Browse to and double-click the library you want to set as the current library. The Select Library dialog box closes.

2. From the InfoMaker main window, on the toolbar, click Open. The Open dialog box opens, displaying the list of templates in the current library.

3. Select the template you want to modify and click OK. The template opens in the Report Painter.

   - To modify the template’s data source (SQL select statement), from the Design menu in the Report Painter, select Data Source. The template opens in the SQL Select Painter. When you are done making modifications in the SQL Select Painter, from the File menu, select Close to return to the Report Painter.

5. To save your modifications, from the File menu, select Save, OR, to save the modified file as a new template, from the File menu select Save As.

Note

If the goal of your edits is to modify one of the standard templates that ship with ICM, consider saving the file under a new name. If you save the file to its original name, and subsequently need to reinstall the Admin Workstation, your modifications will be overwritten.
How to Delete a Template

As necessary, you can delete template files. Once a template is deleted, it is no longer available for use in WebView.

To delete a template:
1. From the InfoMaker main window, on the toolbar, click **Library** to open the Library Painter.
2. Browse to the directory containing the template’s library file.
3. Double-click the library file to display its contents.
4. Right click on the template you want to delete.
5. From the popup menu, select **Delete**.
6. Refresh the report cache to make certain the template’s menu item is removed from WebView (for instructions on refreshing the cache, see “How to Refresh the Reporting Cache” section on page 5-1).

**Figure 4-1  The Library Painter**

---

**Note**

If WebView users have created and saved reports based on a subsequently deleted template, these reports will continue to exist in WebView and will throw errors when run. Therefore, after deleting a template, be certain to delete any associated reports in WebView.
Deploying Custom Templates

This chapter describes how to open new templates in ICM WebView and how to distribute your custom templates to make them available to other Admin Workstation installations. It contains these sections:

- How to Access New Templates in WebView, page 5-1
- How to Prevent a Template from Displaying in WebView, page 5-2
- How to Distribute Templates to Other Template Libraries, page 5-3

How to Access New Templates in WebView

The custom templates you create in InfoMaker are immediately available to ICM WebView and, following a refresh of the report cache, appear alongside the standard report templates in the WebView interface.

As with the standard templates, when you open a new custom template in WebView you can make further changes and additions such as adding thresholds and drill-downs (for templates that support WebView’s drill-down and threshold features).

How to Refresh the Reporting Cache

Template file names are stored in a cache on the Admin Workstation server. At startup, WebView reads this cache to determine what templates are available for use. When you create a new template, it may be necessary to refresh the cache before your new template becomes visible in WebView.

There are two ways to refresh the cache:

- The reporting cache refreshes automatically based on a configurable refresh rate. The default refresh rate is 120 minutes. For instructions on configuring the cache refresh rate, see the Cisco ICM/IP Contact Center Enterprise Edition Installation and Administration Guide, Release 6.0(0).
- You can force a manual refresh of the cache by restarting the Web Server (that is, IIS) on your Admin Workstation.
Chapter 5      Deploying Custom Templates

How to Start WebView

To start ICM WebView:
1. Open a browser window. In the Address bar, enter a URL comprised of the ICM Admin Workstation
   server name and the ICM instance on that server whose templates you want to view. For example:
   http://my_aw_server/instance1.
2. Enter your WebView username and password.
3. Click OK. The WebView splash page opens.

How to Open a Template in WebView

To open a template in WebView:
1. From the report menus on the left side of the WebView screen, expand the menu that corresponds to
   the template’s report type.
2. Select Create a Report.
3. Select the desired template and Click Next.
4. As prompted, select whatever items you want to include in the report. If you are creating a historical
   report, you will also be prompted to specify a date/time range.
5. Click Finish.

Once you generate a report from a template, you can save it to a report definition file. The custom report
templates remain listed in the template launcher until you delete them.

Note
For more information on accessing and using WebView, see the WebView Installation Guide and
WebView’s online Help.

How to Prevent a Template from Displaying in WebView

In some cases, you may prefer that a template not be available in WebView; if, for example, it is only
partially complete or requires a period of internal testing.

There are several strategies you can use to ‘hide” a template from WebView until such time as you are
ready to make it visible.

- WebView only displays templates that contains valid SQL arguments. Therefore, you can hide a
  template by omiting its arguments until you are ready to use it.
- WebView only displays templates stored in the standard libraries that ship with ICM. Therefore, you
can hide a template by creating and storing it in your own library file. Once you are ready to use it,
you can move it to one of the standard template libraries.
Chapter 5  Deploying Custom Templates

How to Distribute Templates to Other Template Libraries

To make a custom report template available from a different Admin Workstation, or from a different library on the current Workstation server, you must copy its file and move the copy to the desired target library.

There are two ways to move a copy of a template file to a library:

- **Directly using InfoMaker:** If you are copying a template to a different library on the current Admin Workstation server, or if you are copying it to a library on a different AW and your Admin Workstation server has a direct network connection to the target AW, you can complete the move within InfoMaker.

- **Indirectly using a file transfer:** If you are copying a template to a library on a different Admin Workstation server and your Admin Workstation server does not have a direct network connection to the target AW, you must transfer the template’s entire library to the target AW using an available file transfer method (for example, email attachment, FTP, diskette, etc.). You then use InfoMaker to extract a copy of the desired template from the transferred library and place it in the target library.

How to Move Template Files Using InfoMaker

Use this method when copying a template to a different library on the current Admin Workstation server, or when copying it to a library on a different AW if you have a direct network connection to the target AW.

To move a template file using InfoMaker:

1. Start Cisco InfoMaker.
2. On the InfoMaker toolbar, click Library.
3. Browse to the Library containing the template you want to copy. Expand the Library to display its templates.
4. Right-click on the desired template and select Copy from the popup menu. The Select Library dialog box opens.
5. Browse to the target template library.
6. Click Open. If that library already contains an identically named template, InfoMaker will prompt you for confirmation before it overwrites the file.

How to Move Template a File Using a File Transfer

Use this method when copying a template to a library on a different Admin Workstation server to which you do not have a direct network connection.

To move a template file using a file transfer method:

1. Transfer a copy of the template’s library (.pbl) file to the target Admin Workstation server using any standard file transfer method (for example, as an email attachment, or through FTP, Telnet, or diskette).
2. On the target AW, when the library file is received:
   a. Start Cisco InfoMaker.
How to Distribute Templates to Other Template Libraries

c. Browse to the location of the transferred file and add it to your Library list.

d. Click OK.

e. On the InfoMaker toolbar, click Sel Lib:

f. Browse to the location of the transferred library file.

g. Expand the Library to display its templates.

h. Right-click on the desired template and select Copy from the popup menu. The Select Library dialog box opens.

i. Browse to the target template library.

j. Click Open. If that library already contains an identically named template, InfoMaker will prompt you for confirmation before it overwrites the file. Right-click and choose Copy. The Select Library dialog box appears.

Note: Similarly, you could use this method to overwrite an entire template library file with one from a different AW. Note however that this will not cause the loss of customized templates currently stored in the overwritten library.
Creating Sample Report Templates

As practice, you may want to try creating several sample templates before undertaking your first actual WebView template. This appendix provides specifications you can use to create several sample templates. It contains these sections:

- How to Create a Sample Real-Time Template, page A-1
- How to Create a Sample Historical Template, page A-3

The instructions provided in this appendix assume that you are familiar with the basics of InfoMaker described in previous chapters.

How to Create a Sample Real-Time Template

This section provides instructions for creating a sample real-time report template for use with peripheral services.

About the Sample Real-Time Template

You will be creating a graph template that displays data for several selected peripheral services. This template will use real-time data from the Admin Workstation local database. The template’s SQL statement will use a single retrieval argument.

The completed template will produce a report that looks similar to the following example.
For each service, this template shows two pieces of information from the tables in the Admin Workstation local database:

- Enterprise Name (from the Service table) is the category, or subject of the report template. The category identifies the entities for which the template will retrieve data.
- Calls Offered Half (from the Service_Real_Time table) is the value displayed for each entity.

**How to Create the Sample Real-Time Template**

Create the sample real-time template using the specifications described in the table below, and following the instructions for creating a new template described in Chapter 3, “Creating a New Report Template”.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Create a real-time template using the ICM real-time db: RealTimeDB</td>
</tr>
<tr>
<td>Reporting Element / Template Library</td>
<td>Specify Peripheral Services as the template’s reporting element by selecting this library in which to create the template: icm&lt;icm_instance_name&gt;\aw\custom\persvc\ppb050.pbl</td>
</tr>
<tr>
<td>Presentation Style</td>
<td>Select the following as the presentation style:</td>
</tr>
<tr>
<td>Tables</td>
<td>Select these tables for use in the template:</td>
</tr>
<tr>
<td></td>
<td>- Service</td>
</tr>
<tr>
<td></td>
<td>- Service_Real_Time</td>
</tr>
</tbody>
</table>
How to Create a Sample Historical Template

This section provides instructions for creating a sample historical report template for use with peripheral services.

About the Sample Historical Template

You will be creating a tabular template that displays data for selected peripheral services. This template will use historical data from the ICM central database. The template’s SQL statement will use three retrieval arguments including (because it is a historical template) a start and end date. It will also include one computed field.

The completed template will produce a report that looks similar to the following example.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Columns</td>
<td>Select these table columns for use in the template:</td>
</tr>
<tr>
<td></td>
<td>- Service.EnterpriseName</td>
</tr>
<tr>
<td></td>
<td>- Service_Real_Time.CallsOfferedHalf</td>
</tr>
<tr>
<td>Retrieval Argument</td>
<td>Create a retrieval argument with these attributes:</td>
</tr>
<tr>
<td></td>
<td>Name: list_of_persvc</td>
</tr>
<tr>
<td></td>
<td>Type: Number array</td>
</tr>
<tr>
<td>Where Clause</td>
<td>Create a Where clause with these attributes:</td>
</tr>
<tr>
<td></td>
<td>Column: Service.SkillTargetID</td>
</tr>
<tr>
<td></td>
<td>Operator: IN</td>
</tr>
<tr>
<td></td>
<td>Value: (argument) :list_of_persvc</td>
</tr>
<tr>
<td>Layout:</td>
<td>In the Define Graph Data dialog box, set these attributes for the</td>
</tr>
<tr>
<td></td>
<td>Category Axis: Service_EnterpriseName</td>
</tr>
<tr>
<td></td>
<td>Values Axis: Service_Real_Time_CallsOfferedHalf</td>
</tr>
<tr>
<td></td>
<td>Title: Tasks Offered</td>
</tr>
<tr>
<td></td>
<td>Graph Type: 3D Pie Chart</td>
</tr>
<tr>
<td>Template File Name</td>
<td>Save the template as:</td>
</tr>
<tr>
<td></td>
<td>custom_realtime_tasks_offered</td>
</tr>
</tbody>
</table>

Table A-1 Sample Real-time Template Specifications (continued)
How to Create a Sample Historical Template

For each service, this template shows the following pieces of information from the tables in the ICM central database:

- Enterprise Name (from the Service table) is the category, or subject of the report template. The category identifies the entities for which the template will retrieve data.
- From the Service_Half_Hour table, the following values are displayed for each entity in the report template:
  - DateTime
  - CallsOfferedToHalf
  - CallsAbandQToHalf
  - ServiceLevelToHalf
  - AvgDelayQToHalf
  - CallsHandledToHalf
  - HandleTimeToHalf

This historical template also presents an additional value, AvgHandleTime. This value is computed from two field values in the SQL syntax.

How to Create the Sample Historical Template

Create the sample historical template using the specifications described in the table below, and following the instructions for creating a new template described in Chapter 3, “Creating a New Report Template”.

<table>
<thead>
<tr>
<th>Peripheral Service Name</th>
<th>Date and Time</th>
<th>Service Level %</th>
<th>Calls Offered</th>
<th>Avg Delay in Queue</th>
<th>Calls AbandQ in Queue</th>
<th>Calls Handled</th>
<th>Handle Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service QuickResponse</td>
<td>2/24/00 12:00</td>
<td>100%</td>
<td>323</td>
<td>0</td>
<td>0</td>
<td>323</td>
<td>711</td>
</tr>
<tr>
<td>Service QuickResponse</td>
<td>2/24/00 12:00</td>
<td>100%</td>
<td>323</td>
<td>0</td>
<td>0</td>
<td>323</td>
<td>708</td>
</tr>
<tr>
<td>Service QuickResponse</td>
<td>2/24/00 12:00</td>
<td>100%</td>
<td>323</td>
<td>0</td>
<td>0</td>
<td>323</td>
<td>708</td>
</tr>
<tr>
<td>Service Registration</td>
<td>2/24/00 12:00</td>
<td>0%</td>
<td>233</td>
<td>393</td>
<td>6</td>
<td>213</td>
<td>983</td>
</tr>
<tr>
<td>Service Registration</td>
<td>2/24/00 12:00</td>
<td>0%</td>
<td>233</td>
<td>393</td>
<td>6</td>
<td>213</td>
<td>983</td>
</tr>
<tr>
<td>Service Service</td>
<td>2/24/00 12:00</td>
<td>100%</td>
<td>194</td>
<td>0</td>
<td>0</td>
<td>200</td>
<td>780</td>
</tr>
<tr>
<td>Service Service</td>
<td>2/24/00 12:00</td>
<td>100%</td>
<td>194</td>
<td>0</td>
<td>0</td>
<td>200</td>
<td>780</td>
</tr>
<tr>
<td>Service Service</td>
<td>2/24/00 12:00</td>
<td>100%</td>
<td>194</td>
<td>0</td>
<td>0</td>
<td>200</td>
<td>780</td>
</tr>
<tr>
<td>Summary</td>
<td>16%</td>
<td>217</td>
<td>18</td>
<td>2158</td>
<td>7014</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table A-2  Sample Historical Template Specifications

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Create a historical template using the ICM historical db: HistoricalDB</td>
</tr>
<tr>
<td>Reporting Element / Template Library</td>
<td>Specify Peripheral Services as the template’s reporting element by selecting this library in which to create the template: icm&lt;icm_instance_name&gt;\aw\custom\persvc\ppb 050.pbl</td>
</tr>
<tr>
<td>Presentation Style</td>
<td>Select the following as the presentation style: Grid</td>
</tr>
<tr>
<td>Tables</td>
<td>Select these tables for use in the template:</td>
</tr>
<tr>
<td></td>
<td>- Service</td>
</tr>
<tr>
<td></td>
<td>- Service_Real_Time</td>
</tr>
<tr>
<td>Table Columns</td>
<td>Select these table columns for use in the template:</td>
</tr>
<tr>
<td></td>
<td>- Service.EnterpriseName</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.DateTime</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.CallsOfferedToHalf</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.CallsAbandQToHalf</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.ServiceLevelToHalf</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.AvgDelayQToHalf</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.CallsHandledToHalf</td>
</tr>
<tr>
<td></td>
<td>- Service_Half_Hour.HandleTimeToHalf</td>
</tr>
<tr>
<td>Computed Field</td>
<td>Create a computed field with these attributes:</td>
</tr>
<tr>
<td></td>
<td><strong>Name</strong>: AvgHandleTime</td>
</tr>
<tr>
<td></td>
<td><strong>Computation</strong>: Service_Half_Hour.HandleTimeToHalf divided by (/) Service_Half_Hour.CallsHandledToHalf.</td>
</tr>
<tr>
<td>Retrieval Argument</td>
<td>Create three retrieval arguments with these attributes:</td>
</tr>
<tr>
<td></td>
<td><strong>Name</strong>: services_list</td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong>: Number array</td>
</tr>
<tr>
<td></td>
<td><strong>Name</strong>: start_date</td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong>: DateTime</td>
</tr>
<tr>
<td></td>
<td><strong>Name</strong>: end_date</td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong>: DateTime</td>
</tr>
</tbody>
</table>
Table A-2  Sample Historical Template Specifications (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Where Clause  | Create a three part Where clause with these attributes:  
|               | Column: Service.SkillTargetID  
|               | Operator: IN  
|               | Value: (argument) :services list  
|               | AND  
|               | Column: Service_Half_Hour.DateTime  
|               | Operator: >=  
|               | Value: (argument) :start_date  
|               | AND  
|               | Column: Service_Half_Hour.DateTime  
|               | Operator: <=  
|               | Value: (argument) :end_date  
| Sort Order    | Set the sort order so that records display first  
|               | byService.EnterpriseName in ascending order, and then by  
|               | Service_Half_Hour.DateTime in descending order. |
### Table A-2 Sample Historical Template Specifications (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Layout:   | In the Report Painter, set these attributes for the template:  
            **Title**: Tasks Offered  
            **Column Names**: Modify the default Column Header names to the following:  
            – Service.EnterpriseName to Peripheral Service Name  
            – Service_Half_Hour.DateTime to Date and Time  
            – Service_Half_Hour.CallsOfferedToHalf to Calls Offered  
            – Service_Half_Hour.CallsAbandQToHalf to Calls Aband. in Queue  
            – Service_Half_Hour.ServiceLevelToHalf to Service Level%  
            – Service_Half_Hour.AvgDelayQToHalf to Avg. Delay in Queue  
            – Service_Half_Hour.CallsHandledToHalf to Calls Handled  
            – Service_Half_Hour.HandleTimeToHalf to Handle Time  
            – AvgHandleTime to Avg. Handle Time  
| Row and Column Formatting: | Adjust row heights and column widths to appropriate viewing sizes.  
| | Center all Column header labels. Set all numeric column data to align right.  
| | Set the display format of data in the Service_Half_Hour.ServiceLevelToHalf column to percent (%).  
| | Summary row: Create a summary row that includes data totals for the following:  
| | Average of Service_Half_Hour.ServiceLevelToHalf  
| | Sum of Service_Half_Hour.CallsOfferedToHalf  
| | **Sum of** Service_Half_Hour.CallsAbandQToHalf  
| | **Sum of** Service_Half_Hour.CallsHandledToHalf  
| | **Sum of** Service_Half_Hour.HandleTimeToHalf  
| Template File Name | Save the template as:  
| | custom_task_analysis_half_hour |
How to Create a Sample Historical Template
Template Libraries and Report Categories

This appendix describes how ICM stores report templates and provides a listing of WebView report categories. It contains these sections:

- About Template Libraries, page B-1
- About WebView Report Categories, page B-1

About Template Libraries

ICM report templates are stored in and accessed from PowerBuilder library files (PBLs) on your ICM Workstation server. A separate library file exists for each WebView report category (for example: call type, agent team, or routing client), and each library file is stored in its own subdirectory within the icm<icm_instance_name>\aw\custom directory.

It's important that you select the appropriate library when creating a new template: this is what associates the template with a specific WebView report category, ensuring that it displays under the correct menu in WebView and has access to the correct retrieval values.

Both real-time and historical templates are stored in the same library file for a specific report category. So, for example, the templates for call type real-time and historical reports are all stored in the library file located in the caltyp subdirectory.

WebView will only recognize and display templates from the standard libraries that ship with ICM. In other words, you cannot create your own library files and display their templates in WebView. However, you can create your own libraries to store templates under development, or templates that you want to remove from WebView but retain for possible future use. See the InfoMaker documentation for instructions on creating new libraries.

About WebView Report Categories

The following table lists all WebView report categories, and their associations:

- Column 1, WebView Report Category, lists the name of the report category.
- Column 2, Library Subdirectory, lists the subdirectory on the Admin Workstation server where the report category’s library file is stored.
- Column 1, ID Argument, lists the ICM database column that should be used with the ID argument (in a template’s SQL statement) for templates of this report category.
Column 4, *WebView Menu*, lists the menu from which templates that use this report category are available in Webview.

### Table B-1 WebView Report Categories

<table>
<thead>
<tr>
<th>WebView Report Category</th>
<th>Library Subdirectory:</th>
<th>ID Argument</th>
<th>WebView Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent by agent</td>
<td>peragt</td>
<td>SkillTargetID</td>
<td>Agent &gt; By Agent</td>
</tr>
<tr>
<td>All agents by team</td>
<td>agteam</td>
<td>AgentTeamID</td>
<td>Agent &gt; By Team</td>
</tr>
<tr>
<td>All agents by peripheral</td>
<td>agtper</td>
<td>PeripheralID</td>
<td>Agent &gt; By Peripheral</td>
</tr>
<tr>
<td>All agents by skill group</td>
<td>agtskg</td>
<td>SkillGroupSkillTargetID</td>
<td>Agent &gt; By Skill Group</td>
</tr>
<tr>
<td>Application gateways</td>
<td>apgate</td>
<td>ApplicationGatewayID</td>
<td>Application Gateway</td>
</tr>
<tr>
<td>Application path</td>
<td>appath</td>
<td>ApplicationPathID</td>
<td>Application Path</td>
</tr>
<tr>
<td>Blended agent campaign</td>
<td>bacamp</td>
<td>CampaignID</td>
<td>Blended Agent &gt; Campaign</td>
</tr>
<tr>
<td>Blended agent dialer</td>
<td>badial</td>
<td>DialerID</td>
<td>Blended Agent &gt; Dialer</td>
</tr>
<tr>
<td>Blended agent dialer port</td>
<td>badprt</td>
<td>DialerID</td>
<td>Blended Agent &gt; Dialer Port</td>
</tr>
<tr>
<td>Blended agent import rule</td>
<td>baimp</td>
<td>ImportRuleID</td>
<td>Blended Agent &gt; Import Rule</td>
</tr>
<tr>
<td>Call types</td>
<td>caltyp</td>
<td>CallTypeID</td>
<td>Call Type</td>
</tr>
<tr>
<td>Enterprise skill groups</td>
<td>entskg</td>
<td>EnterpriseSkillGroupID</td>
<td>Skill Group &gt; Enterprise</td>
</tr>
<tr>
<td>Enterprise services</td>
<td>entsvc</td>
<td>EnterpriseServiceID</td>
<td>Enterprise &gt; Service AND Service &gt; Array</td>
</tr>
<tr>
<td>Network trunk groups</td>
<td>nettrk</td>
<td>NetworkTrunkGroupID</td>
<td>Trunk Group &gt; Network</td>
</tr>
<tr>
<td>Peripherals</td>
<td>periph</td>
<td>PeripheralID</td>
<td>Peripheral</td>
</tr>
<tr>
<td>Peripheral skill groups</td>
<td>perskg</td>
<td>SkillTargetID</td>
<td>Skill Group &gt; Base Only AND Skill Group &gt; Peripheral</td>
</tr>
<tr>
<td>Peripheral services</td>
<td>persvc</td>
<td>SkillTargetID</td>
<td>Service &gt; Peripheral</td>
</tr>
<tr>
<td>Routes</td>
<td>routes</td>
<td>RouteID</td>
<td>Route</td>
</tr>
</tbody>
</table>
## Table B-1  WebView Report Categories (continued)

<table>
<thead>
<tr>
<th>WebView Report Category</th>
<th>Library Subdirectory:</th>
<th>ID Argument</th>
<th>WebView Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing clients</td>
<td>rtecli</td>
<td>RoutingClientID</td>
<td>Routing Client</td>
</tr>
<tr>
<td>Schedule imports</td>
<td>schimp</td>
<td>ScheduleID</td>
<td>Schedule</td>
</tr>
<tr>
<td>Script queue</td>
<td>scriptq</td>
<td>ScriptID</td>
<td>Script Queue</td>
</tr>
<tr>
<td>Trunk groups</td>
<td>trkgrp</td>
<td>TrunkGroupID</td>
<td>Trunk Group &gt; Peripheral</td>
</tr>
</tbody>
</table>
Considerations When Making Custom Reports

You should be aware of the following when making custom reports:

- **Use of an External Database, page C-1**
- **Network Queue and Local Queue Time in TCDs, page C-1**
- **RONA TCD and the Counting of Redirected Calls, page C-1**
- **DBDataTime in HDS to Improve Extracts, page C-2**

**Use of an External Database**

Cisco does NOT recommend that you do any reporting on the TCD (Termination Call Detail), the Route_Call_Detail (RCD) or the TCV (Termination Call Variable) database tables within a production system logger, or even a production system HDS.

However, if you plan to use the data in these tables, you should set up periodic off-peak-hour extracts into an external database, and run your reports in that external database. The Cisco Technical Assistance Center (TAC) Web Site at Cisco.com can give you recommendations on how to do these extracts.

**Network Queue and Local Queue Time in TCDs**

In ICM 5.0, the time spent in the router queue and in the local queue was stored in the same database field, LocalQTime.

In ICM 6.0, the Termination Call Detail Records have a new Field called NetQTime. This field records the Time spent in the Network Queue (Router queue). This is different from the LocalQTime field that records the time spent in the local queue (at the ACD).

**RONA TCD and the Counting of Redirected Calls**

The call disposition record for incrementing RONA data, the number of calls that Redirect On No answer from the agent's phone has changed in ICM 6.0:

- In ICM 5.0, a call disposition of 15 increments the RONA data and a call disposition of 19 is unused and increments errors.
- In ICM 6.0, a call disposition of 19 increments the RONA data, and a call disposition of 15 is the call disposition of redirected calls (as opposed to “abandon ring no answer” calls and is used than an agent or device (voice mail) does not take the call.

When creating customized reports, this change allows for the counting of redirected calls.

DBDateTime in HDS to Improve Extracts

In ICM 6.0, there is a new database field **DBDateTime** included in all of the Half-Hour tables, the Route_Call_Detail, the Termination_Call_Detail, the Route_Call_Variable, and the Termination_Call_Variable tables.

The **DBDateTime** field is a Date/Time indicator that tells what time a record was written to the HDS. Cisco cannot guarantee that records will be written to the HDS in order and a person writing an extract does not know if new records have been added since the last time that person did an extract. This new field solves this problem so that you can determine whether or not you have already extracted a particular record.

For new records in the HDS, the DBDateTime field will be populated with the date and time that the record was written to the HDS. For migrated records, the DBDateTime field will be null.
INDEX

A

Admin Workstation local database  2-2
agteam directory  B-2
agtper directory  B-2
agtskg directory  B-2
apgate directory  B-2

C

caltyp directory  B-2
Central database, ICM  2-2
Column(s)
adding  3-16
computed  3-15
deleting  3-17
Computed columns
creating in design mode  3-15
Copying templates  5-3
Custom Screen Builder
Select painter  3-5
Select Tables window  3-5
starting  1-2
Custom templates
launching  5-1, 5-2
saving  3-18

D

Database
distributor  2-2
Profiles window, InfoMaker  3-2

specifying  3-1
tables and rows  2-1
DB Prof button, InfoMaker  3-2
Distributor database, ICM  2-2

E

entskg directory  B-2
entsvc directory  B-2
Environment window, InfoMaker  1-4, 5-3

H

Historical
Database Server (HDS)  2-2

I

ICM
central database  2-2
distributor database  2-2

L

Library
button, InfoMaker  1-4, 5-3, 5-4
Local Database, Admin Workstation  2-1, 2-2

N

nettrk directory  B-2
New button, InfoMaker  3-4

P
periph directory  B-2
perskg directory  B-2
persvc directory  B-2
Pie chart template,
creating  A-1
PowerBar buttons  1-3

R
RealTimeDB  2-2
Real-time templates,
creating  A-1, A-3
Report(s)
   bar graph  2-3
   pie chart  2-3
   real-time template
   specifications  A-2,  
   A-5
   tabular  2-3
   templates
   visual presentation  2-3
routes directory  B-2
rtecli directory  B-3

S
schimp directory  B-3
Skill target IDs  2-3
SQL Select statement  2-1
Subdirectories, report
storage  B-2

T
Template environment,
selecting  3-3

Templates
copying  5-3
launching  5-1
Text button,  
InfoMaker  3-16
trkgrp directory  B-3

W
WebView
launching templates
using  5-2
starting  5-2